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What's New in Polaris and Leap

Legal Notices

© Innovative (Part of Clarivate) and/or its affiliates. All rights reserved. All trademarks
shown are the property of their respective owners.

The information contained herein is subject to change without notice and is not
warranted to be error-free. If you find any errors, please report them to us in writing.

The software and related documentation are provided under an agreement containing
restrictions on use and disclosure and are protected by intellectual property laws.
Except as expressly permitted in your agreement or allowed by law, you may not use,
copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit,
perform, publish, or display any part, in any form, or by any means. Reverse engineering,
disassembly, or decompilation of the software, unless required by law for
interoperability, is prohibited.
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Polaris Installation Notes

Important:

When the new Polaris release is installed on a workstation, the file path
changes from 6.2 to 6.3 as in the following examples:
C:\ProgramData\Polaris\6.3

C:\Program Files\Polaris\6.3

C:\Program Files (x86)\Polaris\6.3

© 2022 Innovative (Part of Clarivate)
Page 1



What's New in Polaris and Leap 6.3

New and Modified Polaris Administration Settings

The following table lists the new and modified profiles, parameters, and permissions in
Polaris Administration.

Setting

Purpose

Level

New Permissions

Cataloging: Adds the ability to permission the undelete of | Staff

Cataloging record | Cataloging record sets that have been

sets: marked for deletion.

Delete/Undelete

Patron record Adds the ability to permission the undelete of | Staff

sets: Patron record sets that have been marked for

Delete/Undelete deletion.

Leap: Setup Controls which users can complete the Leap | System

Offline: Allow Offline installation.

System Allows you to modify the new Database table, | Staff, Workstation,
Administration: Genders Table. Permission Group
Modify genders

table: Allow

Item Bulk Change
Templates:
Access

Allows users to view and use the saved item
bulk change template data.

Staff, Workstation,
Permission Group

Item Bulk Change
Templates: Create

Allows users to create new saved bulk
change templates.

Staff, Workstation,
Permission Group

Item Bulk Change
Templates:
Modify

Allows users to modify existing saved bulk
change templates.

Staff, Workstation,
Permission Group

Item Bulk Change
Templates: Delete

Allows users to delete saved bulk change
item bulk change template data.

Staff, Workstation,
Permission Group

Use 'own' item
bulk change

Allows staff to 'own' item record bulk change
templates.

System
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Setting Purpose Level
templates: Allow
New Profiles
Cataloging: Lets you enable or disable the automatic System
Automatically population of the heading in the Authority
populate authority | Records - Heading Find Tool when checking
heading in Find for duplicate headings.
Tool during check
headings
PowerPAC: Title | Allows you to specify the maximum number | Branch

Display: Number
of characters in
the Summary
(Short)

of characters of the Summary (Short) field
that are displayed in the brief and full search
results views for a title in the Polaris
PowerPAC.

PAC: Reset

Allows you to determine the time period (in

System, Library,

password link minutes) during which the reset password and Branch
timeout duration | link emailed to the patron remains active.

Patron Services: Enables the system to retain deleted patron | Systems
Retain deleted record sets.

patron record

sets.

Cataloging: Retain | Enables the system to retain deleted Systems
deleted cataloging | cataloging record sets.

record sets

New Parameters

Request: Total Lets you specify whether inactive hold System
holds thresholds | requests count toward a patron's total holds

include Inactive limit.

Patron Services: | Allows you to manage gender drop down Branch

Patron
Registration Filter
genders

lists.
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Setting Purpose Level
Patron Services: | Allows you to suppress gender tracking in Branch
Patron Staff Client and Leap.
registration
options

Modified Profiles

PAC: Patron Allows you to suppress gender in Self- Branch
access options: Registration.
Self-registration:
Suppress gender

selection

PAC: Patron Enable option to send patrons a reset Branch
Access Options: | password link.

Login

Modified Parameters:

Credit Card A new JetPay option in the Payment Library, Branch
Payment: Online | processing gateway list allows you to
Payment Settings: | configure Polaris to use JetPay for
Configure processing credit card payments from
PowerPAC.
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MARC Updates Implemented in Polaris 6.3

The updates specified in the October 26, 2018 MARC technical notice were
implemented in Polaris 6.3.
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WebAdmin Updates

The tables below lists the most important new strings added in Polaris 6.3.

ExpressCheck Strings

Mnemonic String Text

EC_TEXT_FORGOTPASSWORD_1010 The e-mail could not be sent. Please
contact the library for assistance.

EC_TEXT_FORGOTPASSWORD_EMAIL_ Click on the following link to set/reset
HOURS your password: Reset Password Link: {0}
This link can be used to reset your
password, and will expire in {1} hours. If
the link is expired, request a new one: {2}
If you did not request to reset your
password, please ignore this message.
Sincerely, Your Library System
Administrator

EC_TEXT_FORGOTPASSWORD_EMAIL_ Click on the following link to set/reset
MINUTES your password: Reset Password Link: {0}
This link can be used to reset your
password, and will expire in {1} minutes.
If the link is expired, request a new one:
{2}If you did not request to reset your
password, please ignore this message.
Sincerely, Your Library System
Administrator

MobilePAC Strings

Mnemonic String Text

MP_ACCOUNTLOGON_RESET_SUCCESS Your password has been reset.

MP_CRUMBS_RESETPWD Reset Password

© 2022 Innovative (Part of Clarivate)
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Mnemonic String Text

MP_HOLD_REQ_AVAIL_ERROR

Hold Requests are not allowed for this
title

MP_MSG_FORGOTPASSWORD_EMAIL_
HOURS

Click on the following link to set/reset
your password: Reset Password Link: {0}
This link can be used to reset your
password, and will expire in {1} hours. If
the link is expired, request a new one: {2}
If you did not request to reset your
password, please ignore this message.
Sincerely, Your Library System
Administrator

MP_MSG_FORGOTPASSWORD_EMAIL_
MINUTES

Click on the following link to set/reset
your password: Reset Password Link: {0}
This link can be used to reset your
password, and will expire in {1} minutes.
If the link is expired, request a new one:
{2} If you did not request to reset your
password, please ignore this message.
Sincerely, Your Library System
Administrator

MP_MSG_FORGOTPASSWORD_INFO_
BARCODE_RESET

Your reset password link has expired.
Please submit your Barcode below to
request a new one.

MP_MSG_FORGOTPASSWORD_INFO_
USERNAME_RESET

Your reset password link has expired.
Please submit your Username or
Barcode below to request a new one.

PowerPAC Strings

Mnemonic String

PACML_DASH_CHILDFICTIONSERIES

Children's Fiction Series

© 2022 Innovative (Part of Clarivate)

Page 7




What's New in Polaris and Leap 6.3

Mnemonic String Text

PACML_DASH_CHILDILLUSTRATED

Children's Illlustrated

PACML_DASH_DONATION

Make a Donation

PACML_DASH_EARLYMIDDLE

Early and Middle Grade Readers (sys
cust)

PACML_DASH_HARDFICTION

Hardcover Fiction

PACML_DASH_HARDNONFICTION

Hardcover Non-Fiction

PACML_DASH_MASSMARKET

Mass Market

PACML_DASH_MOSTCIRCAUTHORS

Most Circ'd Authors

PACML_DASH_MOSTCIRCSUBJECTS

Most Circ'd Subjects

PACML_DASH_MOSTCIRCTITLES

Most Circ'd Titles

PACML_DASH_NEWTITLES

New Titles

PACML_DASH_ONORDERITEMS

On-Order Items

PACML_DASH_PAPERFICTION

Trade Paperback Fiction

PACML_DASH_PAPERNONFICTION

Trade Paperback Non-Fiction

PACML_DASH_YOUNGADULT

Young Adult

PACML_FORGOTPASSWORD_1014

Your reset password link is invalid or has
expired. Please submit your Username
or Barcode below to request a new one.

PACML_FORGOTPASSWORD_1015

Your reset password link is invalid or has
expired. Please submit your Barcode
below to request a new one.

PACML_FORGOTPASSWORD_CONFIRM

Confirm Password:

PACML_FORGOTPASSWORD_EMAIL_
HOURS

Click on the following link to set/reset
your password: Reset Password Link: {0}
This link can be used to reset your
password, and will expire in {1} hours. If
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Mnemonic String Text

the link is expired, request a new one: {2}
If you did not request to reset your
password, please ignore this message.
Sincerely, Your Library System
Administrator

PACML_FORGOTPASSWORD_EMAIL_
MINUTES

Click on the following link to set/reset
your password: Reset Password Link: {0}
This link can be used to reset your
password, and will expire in {1} minutes.
If the link is expired, request a new one:
{2} If you did not request to reset your
password, please ignore this message.
Sincerely, Your Library System
Administrator

PACML_FORGOTPASSWORD_INST

Please create a new password. You will
then be directed to log in.

PACML_FORGOTPASSWORD_NEW

New Password:

PACML_FORGOTPASSWORD_SHOW

Show password

PACML_FORGOTPASSWORD_TITLE

Reset Password

PACML_JETPAY_DONATION_NOTE

Thank you for your Donation.

PACML_JETPAY_PAYMENT_NOTE

Thank you for your payment.

PACML_JETPAY_TRANSACTION_ERR

There is a problem with your payment.
Please contact the library for assistance.

PACML_LOGON_PASSWORDRESET

Your password has been reset.

PACML_PROCESSINGFEES_JETPAY_ERR

JetPay fee is $0.00 or there was a
JetPay API error. You will see the fee
when you are at the JetPay site.

PACML_SUMMARYLESS

Less

PACML_SUMMARYMORE

More
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Polaris API Changes

The table below is a list of changes to the Polaris APIs for v6.3.

Method Name Purpose

PickupBranchesGet This new endpoint returns a list of valid
pickup branches based on the
organization ID.

ShelfLocationsGet This new endpoint returns a list of shelf
locations based on the organization ID.

Synch_BibsPagedGet This new endpoint allows a paged
extraction of bib record data.

ltemUpdateBarcode The new parameter BarcodeOrID has
been implemented that enables a
barcode to be updated using either the
item ID or the item barcode as an
identifier. An additional new parameter,
isBarcode, specifies whether the
identifier used is an item record ID or a
barcode.

PatronHoldRequestGet A new CanSuspend Boolean property
has been added that indicates whether
a patron’s hold request can be
suspended.

PatronReadingHistoryClear Now removes a range of historical
reading history entries by specifying
their ID using the new id query string
parameter.

For more information, see the Polaris APl Reference for v6.3.
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Bulk Update Purchase Order Notes

You now have the ability to update purchase order line item notes in bulk from the
Purchase Order workform.

The Update Note option is now in the right-click menu for purchase order line items. You
can select one or more notes to update with this option.

] Purchase Order - 24612 - Line ltems - Polaris | ==

DNEHES X 82X NMO ' & 9

Number: | SAR33 i | status:  [Pending | [3/14/2018 |

Type:  |Firm Order Lnes: |21 | Total: [$398.24 | method |purchase [ ]

Line Items

D ANBEEQEWNE B| 8

Line... Title Author ISBN /ISSM Amount  Orde...
Intermediate English (ESL) ... 1573850020 (L... $80.00 1
Perfecting the sounds of A...  Silverstein, ...  084420479X $17.95 1

Time and again Roberts, Mo...

Instant immersion. English ...

Instant immersion. English ... Place Hold

ece... Invei.. Fund Status A
Pending
Pending
Pending
Pending
Pending

-
o
o
@)
job)
0
N
o
o
|
Q.

R
1 a a
2 1] 1]
3 a a
5 1] 1]
6 1] 1]
7 American English pronunda... o Receive 0 0 Pending
'8 Teach yourself. American ... Undo Receipt 0 0 Pending =
t g Teach yourself, English vo... 065 0 0 2017BR...  Pending
t 10 Common American phrases... Spears, Ric... 1Z3| I Update Note I | 0 0 2017BR...  Pending
11  English for new Americans.... Pifieiro, Carol, 140 ' Copy To ... 1] 1] 2017BR...  Pending
t 12 InEnglish on your own [DVD] 034 Tefnr 0 0 2017BR...  Pending
13 Crossroads Cafe [videorec... 1} 1} 2017BR...  Pending
t 14 Engish for new Americans.... 060 anes 0 0 2017BR...  Pending
15  Easy English : [DVD] an ES... Close i} i} 2017BR...  Pending
16 Easy English : [videorecord... Print 3 0 0 2017BR...  Pending
17  Culture dips [videorecording] . i} i} 2017BR...  Pending
18 Fast &easy. Ingles basico ... 958 Links L 0 0 2017BR...  Pending v
= Delete =
The operation was canceled. :
; Properties —
Note:

This menu option is not enabled if any of the selected purchase order line
items have a status of Closed.

Selecting this option will open the Update Notes dialog with two note types:

¢ Public Note
e Non-Public Note

Both note types have the following options:

© 2022 Innovative (Part of Clarivate)
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o Replace - replaces the existing note.
° Prepend - inserts the new note and a blank line before the existing note.
o Append - inserts a blank line and the new note after the existing note.

Update Motes -
Motes
[ Public note:
Replace Prepend Append
[IMon-public note:
Replace Prepend Append
oK | | Cancel | | Help

If Replace is selected and text is not entered in the note field, the existing note will be
deleted.

Notes longer than 255 characters will be truncated to 255.

If prepending or appending causes a note to be larger than 255 characters, you will see
the following message:

Polaris -

i B | Prepending / appending note data to Line Number 1 will cause the
k ' Inote to be truncated to 255 characters, Do you want to update the
note?

[1Do not warn me again

 Yes - updates the note(s).

» No -returns you to the Purchase order updating only the line items where the data
would not be truncated. The above message will appear for each line item that
may be truncated.

© 2022 Innovative (Part of Clarivate)
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« Cancel - returns the user to the purchase order with the line item(s) still high-
lighted.

© 2022 Innovative (Part of Clarivate)
Page 13



What's New in Polaris and Leap 6.3

New Index to Increase Workslip Speed

A new index was added to speed up the printing of PO line item work slips.
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Automatically Populate Authority Heading in Find Tool
During Check Headings - Staff Client

A new administration setting lets you enable or disable the automatic population of the
heading in the Authority Records - Heading Find Tool when checking for duplicate
headings.

Open Administration Explorer > Profiles > Cataloging:

Administration Explorer - System - QA-YODA 6.3 - Polaris
File Edit Help

h-=2-H EY
Adm\nlstrat\on Explorer - Sy ﬁPrDﬂles
ﬂ Administration Explorer - S
= gﬂg System: QA-Polaris
| Parameters

-4 Profies |

------ ¥ Permissions Brofil val
Securty rofile alue

Policy Tables Automated MARC validation: Authority Yes
Database Tables
=] Notification Tables

Acquisitions / Serials Patron Services | Cataloging | PAC  PowerPAC Children's PAC Staff Client Mobile PAC Community

Automatically sort MARC authority records Yes
12} Branch %Automatically sort MARC bibliographic records No

&P Collection [=3Bibliographic records: Automatic display in PAC processing

The default value for this setting is No.
It is available at the System, Library, Branch, Work Station, and Staff Member levels.
If this setting is enabled, the Find Tool is automatically populated when:

1. The useris working in a bibliographic record with an unlinked heading.

© 2022 Innovative (Part of Clarivate)
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2. Aheading check is triggered either by saving the record as final or by selecting
Check Headings from Tools in the record workform:

Bibliographic Record 1281015 - MARC21 - Polaris
File Edit View Links |Tools Help
D @, E - Check Headings Ctrl+) g ”ﬂ
f———Cleckc MARE2 Format Ctrl+M
"O Control numb Replace / Check For Duplicates Ctrl+1 )
LO'. Place Hold... Ctrl+H
Title:
@) Sort
& —— Add to Record Set >
Tag Ind
Q LDR Create Item Records
== nn1 Create Serial Holdings Record

3. The Check Headings Assistant Dialog Box displays the headings with no match-
ing authority record, and the user selects Details for one of the headings:

Check Headings Assistant X
The bibliographic headings with no exact authority matches are listed below. 0K
Heading Solution | Details |
650 7 faluvenile Fiction Leave heading unlinked
Edit Record
Preview
Cancel
Help

© 2022 Innovative (Part of Clarivate)
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4. The Check Headings Details Dialog Box opens, and the user selects Find to
search for a matching heading:

‘Check Heading(s)' Details X

Bibliographic Heading: ‘ 650 7 ¥aluvenile Fiction ‘

Possible Authority Records

Heading
150 #aChildren's stories Open

155 faluvenile fiction.

Find

Conditions
The bib heading tag number does not match this authority record

Solution

() Create new authoritv record

5. The Authority Records - Heading Find Tool appears with the For option pre-
populated using the heading subfield a.:

@ Authority Records - Heading Find Tool — X
File Edit Tools Options Help
General Settings Databases
Object: Authority Records ~ | Limit by: (None) ~ Sl i Seareh
(®) Normal Stop
Search by: |Heading ~ | Value: () Power
Type: Exact match (implicitly truncated) ~ O SQL New Seach
Sortby:  |(None) ~ [ ] Count Only Clear
For: | buvenile Fiction v Help
For Help, press F1 Close on Select

Note:

The user can change the search criteria before executing the search in the
Find Tool and search terms do not persist between searches.

© 2022 Innovative (Part of Clarivate)
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Retain Bibliographic Control Number During Over-
lay/Replace

Duplicate detection now maintains the control number of the existing bibliographic
record by default during the import overlay/replace process. Import permissions remain
unchanged.

When you choose Save incoming record as final; replace database record, the existing
record is overlayed by the new incoming record but its control number is retained.

Polaris Import Setup - Full -

Profile setup | Bibliographic Records | 1tem Records I Authority Records I Record Sets |

Bibliographic Save Options

[[] Delete MARC Tags on incoming record
(® Save all records as final

Display in PAC System defined deletion tags
() save all records as provisional Profile defined deletion tags
) [ o not averlay
() Do not save any records
Record owner: | QA-YODA 6.3 (sys) W |

When Saving Bibliographic Records as Final

Perform MARC 21 Validation [CIPerfarm Autharity Contral

If validation errors are found:
. Automatically create new authority record; save bibliographic record as final
(_) Save record as provisional _ o )
Do not create autharity record; save bibliographic record as final

(®) Ignare errors; save record as final Do not create authority record; save bibliographic record as provisional

Perform Duplicate Detection
(®) LUse system defined duplicate detection rules
() Use profile defined duplicate detection rules

If & suspected duplicate is found:

0 save incoming record as provisional

() Save incoming record as final; do not replace database record

[IKeep MARC Tags
System defined overlay retention tags

(®) Save incoming record as final; replace database record

() Save record with highest encoding level, If encoding levels match: Profile defined overlay retention taas

Save incoming record as final; replace database record
Reject incoming record

Save incoming record as provisional (ignore 'Keep MARC Tags’)

() Reject incoming record; add MARC retention tags to database record

Import || Cancel || Help

When you choose Save record with highest encoding level. If encoding levels match:,
the Save incoming record as final; replace database record option is selected by
default. You can also choose to reject the incoming record or save the incoming record
as provisional. The control number is retained only when saving the record as final.

© 2022 Innovative (Part of Clarivate)
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Polaris Import Setup - Full | x|

Profile setup | Bibliographic Records | Ttem Records | Authority Records | Record Sets |
Bibliographic Save Options

[ pelete MARC Tags on incoming record
[l Display in PAC System defined deletion tags

() save all records as provisional Profile defined deletion tags
[1bo not overlay

(®) save all records as final

() Do not save any records

Record owner: | QA-YODA 6.3 (sys) b |

When Saving Bibliographic Records as Final

Perform MARC 21 Validation [[JPerform Authority Control

If validation errors are found:
. . Automatically create new authority record; save bibliographic record as final
(_) Save record as provisional _ o )

Do not create authority record; save bibliographic record as final

(®) Ignore errors; save record as final Do not create authority record; save bibliographic record as provisional

Perform Duplicate Detection
(®) Use system defined duplicate detection rules

() Use profile defined duplicate detection rules

If & suspected duplicate is found:

() Save incoming record as provisional

() Save incoming record as final; do not replace database record [JKeep MARCT:
- ep ags

() Save incoming record as final; replace database record

System defined overlay retention tags
(®) Save record with highest encoding level, If encoding levels match: Profile defined overlay retention tags | (g [
(®) Save incoming record as final; replace database record
O Reject incoming record
() Save incoming record as provisional (ignore 'Keep MARC Tags')
() Reject incoming record; add MARC retention tags to database record
Import | | Cancel | | Help

Interactive Save of a Brand New Record

When creating a new bibliographic record, or importing and saving a new bibliographic
record using z39.50, the control number of the existing record will automatically be
retained when there is only one duplicate. You can choose which control number to
retain when there are multiple duplicates available.

A new column called Maintain control number has been added to the Duplicate
Detection dialog.

© 2022 Innovative (Part of Clarivate)
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Replace / Check For Duplicates (Bibliographic Records) -
Retain this record:
Controln...  Owner Title Author Format Linked items Status
QA-YODAG.... Horses/ Reddick, Kate. 0
i R 5 &
Maintain control number Control nu...  Owner Title Author Format Linked items Status System-de

Reddick, Kate,  Book

< m >

| Replace All | |Replace Selected Cancel | | Help

If only one duplicate is found, the checkbox is checked by default and cannot be
unchecked. the control number of the suspected duplicate will be the one retained. The
record owner is also retained. This requires the Bib record modify permission
(overridable), and will update the modification date of the existing record.

Replace / Check For Duplicates (Bibliographic Records) [
Retain this record:
Controln...  Owner Title Author Format Linked items Status
QA-YODA 6.... Horses [ Reddick, Kate. 1]

Records to replace: |§| IEI

Maint... Control nu...  Owner Title Author Format Linked items Status System-detected duplicate

142273 QA-YODA ... Horses Reddick, Kate.  Book 3 Final LCCN; Author /Title; Tite/260 Sc;

£ m >
| Replace Al | | Replace Selected | | Cancel | | Help |

If more than one suspected duplicate record is found, the user will have the option to
select which records to replace, and of those records, which control number will be
retained.
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Replace / Check For Duplicates (Bibliographic Records) 2
Retain this record:
Controln...  Owner Title Author Format Linked items Status
QA-YODA 6.... Horses [ Patent, Dorothy Hin... o

Records to replace: IEI IEI S

Maint... Control nu... Owner Title Author Format Linked items Status System-detected duplicate

O 468457 QA-YODA ... Horses Patent, Doro...  Book z Final LCCN;ISBN; Author [Title; Title /24

O 1413811 QA-YODA ... Horses Patent, Doro...  Book 1 Final LCCN;ISBN; Author Title; Just Ti

£ m >
| Replace All | | Replace Selected | | Cancel | | Help |

Records in a status of provisional are not eligible for this feature, and will have a
disabled checkbox.
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Saving Default Remote Databases for Bibliographic
Record Searches

You can now save default remote databases that Polaris searches when you use the
Find Tool to search for bibliographic records.

Note: Default search databases are associated with your user account.

To save default search databases:

1. Open the Find Tool for bibliographic records and navigate to the Databases tab.
2. Select the remote databases you would like to search.
3. Select Options > Save as User Default.

Polaris saves your preferred remote search databases. When you open the Find

Tool for bibliographic records in the future, your preferred search databases are
already selected.

To clear saved default search databases:

1. Open the Find Tool for bibliographic records, and navigate to the Databases tab.
2. Select Options > Revert to System Default.
If an administrator deletes a remote database that is being used as a default search

database by one or more users, the database is automatically removed from each user's
saved default search databases.
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Save Item Record Bulk Changes as Templates

You now have the option to save item record bulk change settings as templates to reuse
your item bulk change criteria. This feature is available in the Staff Client and Leap.

The following new permissions must be assigned to enable this feature. They can be
assigned at the Permission Group, Workstation, and Staff member levels.

At the branch level, Item Bulk Changes Templates:

Access — allows users to view and use the saved criteria.

Create — allows users to create new saved bulk change templates.

Modify— allows users to modify existing saved bulk change templates.

Delete — allows users to delete saved bulk change criteria.

File Edit Help

- ." Adjacent Test Branch One
+-{8) Adjacent Test Branch Three
+-fa Adiacent Test Branch Two
+ Amsterdam Free Library

+ {8 Argyle Free Library

+ ‘ Ballston Spa Public Library
+ ~f& Bancroft Public Library (Salem

+-8) Bolton Free Library

+1-f& Bumt Hills - Town of Ballston (
+ & Cambridge Public Library

+ ‘ Canajoharie lelary.r

PI’D‘fI|ES

.. (\ Carirth's Free |ikrane
£ m >

For Help, press F1

ministration orer - em - QA- - Polaris =
Ad stration Expl S QA-YODA 6.3 - Pol = -
E?
plorer - System 2 Security
"~
P
Test Branch 1 (Library 8) sty
= Control Record Individuals With Permission A
- Permission Group
= @ Cataloging ~ W Administrator )
# (23 Authority templates il =1 - Workstation
+ 7 Bibliographic records ggmeryl.stewart Staff Member
+ [Z7 Bibliographic templates ?EJUAnne.Zukﬂwski
# (23 Campaigns = Fremarycay.phelps
+ £ Cataloging record sets - @ M
+ [E3 Community records @A Cocca
+ 2] Course reserve records & ams 102
+ Course regerve templates @ 103
= 23 Ttem Bulk Change Templates ams
SED S
Parameters 2§ Create @amslﬂ
4 Delete B ams21
2§ Modify BB ams7
@ams?‘qﬂﬂ
+_[77] Item templates e 8B Andy Hoaa hd
< m > <| m >
W
B2 cherylstewal

The following new permission is necessary if the library wants to allow staff to 'own'
item record bulk change templates. If the library wants all templates to be owned at the
sys/lib/branch levels, then they would not assign this permission to staff.

At the system level: Use 'own' item bulk change templates > Allow.
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P Administration Explorer - System - QA-YODA 6.3 - Polaris = || = -
File Edit Help
mﬂdministmtion Explorer - System é Security
| Administration Explorer - System ~ —|
= System: QA-Polaris = Security
Parameters Control Record Individuals With Permission
Profiles o
Permissiong (& Remove | | Assign v|
Permission Grou
: + (£ Suppress warnings for breakable lir ~ HAdministrator ] 2
+-{£] Database Tables +# (20 Suppress warnings for breakable lir Wl - Workstation
+|-{f] Metffication Tables + (3 suppress warnings for unbreakable ?Eﬁeryl.st&wart Staff Member
+G Server + (2] Suppress warnings for unbreakable §2J0Anne.2uk0u\'sld
+iv Library # [Z3 Use 'own' authority templates B2marycay.phelps =
—|--fmt Branch # 23 Use 'own' bibliographic templates & 3m
+ _Test Branch 1 (Library 8} + (£ Use 'own’ cataloging record sets @A Cocea
+ Adjacent Test Branch One Lot FYSREIPES @ 102
+ Adjacent Test Branch Three =l 3 Use 'own' item bulk change templat ams
+ Adjacent Test Branch Two j Allow | BB ams103
+1-{8) Amsterdam Free Library [#_[71 Use 'own’ item templates &ams12
+- {8 Arayle Free Library [# [Z3 Use 'own’ reserve item templates | = S ams20
+- 8y Ballston Spa Public: Library # (23 Use URL detective BB ams21
+ Bancroft Public Library (Salem @ Circulation @ams?
+-{8) Batton Free Library @ Public Access Catalog & ams7400
+1-18) Bumt Hills - Town of Ballston B serizls e B Andy Hoag v
+ Cambridge Public Library < m > < >
+--fay_Canainharia | ibrane hd
< m >
For Help, press F1 B2 cheryl.stewal

The Staff Client Item Bulk Change dialog is updated to include these options:

» Template — select an existing item record bulk change template available to you.
» Save — modify an existing template.
» Save As - save item bulk change criteria as a new template.
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» Delete — delete an existing template.

Item Record Bulk Change - Number of records: 5 -

Template: |(Ngne) v| Save Delete

Location |Circu|ation | Call Mumber | Motes/Blocks | Misc I Report/Record Set |

[] owner:

[] Assigned branch:
[] Assigned collection:
[] shelflocation:

[ Home branch:

|:| Temporary location:

0K || Cancel || Help

The Leap Item Bulk change workform is updated to include these options:

» SAVE AS TEMPLATE - save item bulk change criteria as a new template.

Item Record Bulk Change

Joan Aiken
cccccc tewart

Bulk Change Report Template
ItemBulkChangeReport_20190617152955.1xt (None)
Error Record Set
Name Owner
cherylst
Q Location O Circulation @ Call Number B Blocks and Notes @ Miscellaneous
Owning Branch Shelf Location
(No change)
Assigned Branch Home Branch
(No change) v (No change)
Collection Temporary Location
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» Template - select an existing item record bulk change template from a list of tem-
plates available to you.

Item Record Bulk Change SAVE AS TEMPLATE m

Joan Aiken

cheryl.stewart

Bulk Change Report Template
ltemBulChangeReport_20190617152955 txt

Error Record Set

Name
Q Location O Circulation @ Call Number B3 Blocks and Notes @ Miscellaneous
Owning Branch Shelf Location
(No change) v No change)
Assigned Branch Home Branch
(No change) v No change)
Collection Temporary Location
(No change) v

Leap also has a new Item Bulk Change Template workform to modify, copy, and delete
item bulk change templates.

Item Bulk Change Template @ ACTIONS ~ C REFRESH GIRESULTS

Name Owner

Joan Aiden template cheryl stewart

Q Location O Circulation @ Call Number B3 Blocks and Notes @ Miscellaneous

Owning Branch Shelf Location

Test Branch 19 (Library 6) (br) v (No change) v
Assigned Branch Home Branch

(No change) v (No change) v
Collection Temporary Location

Children's Adventure (JADV) v
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Undelete Record Sets

Sometimes a record set is deleted by accident, and this can be a difficult situation to
rectify if the user who deleted the set was not the creator.

You can now undelete record sets if this feature has been enabled by the system
administrator. Record sets now have a status of Final or Deleted. If the status of the
record set is Deleted, then staff could use the Undelete action similar to the item record
delete/undelete function.

This functionality can be accomplished in both Leap and the Staff Client.

The following sections provide more information about enabling, configuring, and using
the Undelete Record Set function:

System Administration

o System Administration Options to Retain Deleted Record Sets

e Delete Record Sets Permissions Updated

e Record Set Status
e Record Set Undelete Transactions

Staff Client

Record Set Status in Record Set Header and Properties
Undelete Menu Option and Icon for Record Sets

Find Tool Updated for Deleted Record Sets

Record Set Status in Find Tool Search Results

Leap

e Record Set Status in Record Set Header and Info Properties in Leap
e Undelete Menu Option for Record Sets in Leap
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e Find Tool Updated for Deleted Record Sets in Leap

e Record Set Status in Find Tool Search Results

System Administration Options to Retain Deleted Record Sets

Deleted record sets must be retained to enable the Undelete Record Sets option. These
are system level settings.

To retain Patron record sets, go to Administration Explorer > Profiles > Patron Services
> Retain deleted patron record sets. Select Yes.

File Edit Help

OD-=-H

Administration Explorer -

System - QA-YODA 6.3 - Polaris

&

Adm\n\stratlmn Explorer - Sy ﬁPmﬂIes

E Administration Explorer - S
= %_System: QA-Polaris

I drame
T Permissions
Security
Policy Tables
Database Tables
=] Notification Tables
() Server
- ﬂ’ Library
[+--{=} Branch
@ Collection
@ Workstation
?2 Staff Member
E Patron

— Staff Cliont

Patron Services

Children's PAC
Acquisitions / Serials

Profile

%Contribute to LJ books most borrowed
Default directory

%Display photo 1D

%Due date modification: Reason required
%Patron can enable/disable reading history
[=3Patron custom data: Definition

[=3 Patron custom data: Filter

(=3 Patron initiated circulation: Blocking conditio...
%Patron initiated circulation: Transaction branch

Mabile PAC
Cataloging PAC
+

Value

Yes - Via Web Service
C:\ProgramData\Polaris\6.3\
Yes

No

Yes

Setup . ..

Setup . ..

Setup . ..

Patron's branch

[ Ratron-registration-user-defined-fialds
& Retain deleted patron record sets

< >

For Help, press F1

B2  cherylstewa

Community
PowerPAC

To retain Cataloging record sets, go to Administration Explorer > Profiles > Cataloging >
Retain deleted cataloging record sets. Select Yes.
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Administration Explorer - System - QA-YODA 6.3 - Polaris - | X
File Edit Help

D-@-HX & K

.Administration Explorer - Sy ijﬂIes

B8l Administration Explorer - S Children's PAC Staff Client ile PAC Community
& % System: QA-Polaris Acquisitions / Serials Patron Services Cataloging l PAC PowerPAC
+ ¢
gl:;nl]:;mns Profile Value ~
| Policy Tables % Item records: Warning for items saved with modified ba... No
Database Tables % Item records: Warning for items saved without barcodes No
Notification Tables | KL (tom records: Warning if changing assigned or home br... No
S [i' fiirr\;?; MARC validation immediately after bib replace No
{1 {2} Branch [Z3MARC validation: Authority Setup . ..
-.gP Collection [23MARC validation: Bibliographic Setup . ..
@ Workstation g% Maximum number of files to import 100
ﬁ Staff Member [23Remote automatic authority control Setup . ..
E Patron % Retain deleted authorlty records Yes
IIIL TECOTUS fes
A
et ETETTeToTds es
(%3 Subfield 9 cleanup utility Setup . ..
W
< > < >
For Help, press F1 M2  cherylstewa

Delete Record Sets Permissions Updated

Cataloging and patron record sets permissions are updated to support the ability to
permission the undelete of record sets that have been marked for deletion.
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» Cataloging Record Sets: Delete permission now includes /Undelete

ﬁ Administration Explorer - System Is Permitted To
EF g% System: QA-Polaris
|55 Parameters
Profiles
j Permissions
Security Control Record Permission Subsystem
Policy Tables Campaigns Access Cataloging
Data.base Tables Campaigns Create Cataloging
Notification Tables Campaigns Delete Cataloging
() Server Campaigns Modify Cataloging
&3 b Library Cataloging record sets Access Cataloging
@ .@ Branch Cataloging record sets Create Cataloging
&P Collection Cataloging record sets Delete/Undelete  Cataloging
B3 Workstation Eatatoging-record-sets Modify Catatoging
= F4 Staff Member Check in shelf-ready materials Allowr Acquisitions
=5 ?2 cheryl stewart Circulation check-in workform Access Bulk mode  Circulation
Profiles Circulation check-in workform Access In-house... Circulation
3 Preferences Circulation check-in workform Access Inventor...  Circulation
R Permissions| <
E Patron

o Patron Record Sets

: Delete permission now includes /Undelete

P e

Security Control Record Permission Subsystem

Policy Tables Override renewal limit blocks Allow Circulation

Database Tables Override request blocks Allow Circulation

t Notification Tables Override request limits Allow Circulation

- Server Patron claims: Reset total daim count Allow Circulation

- [fe Library Patron record sets Access Circulation

[+ m Branch Patron record sets Create Circulation
@F Collection Patron record sets Delete/Undelete Circulation |

AR Workstation "Patron record sets Modify Circufation

=- ﬁ Staff Member Patron registration Access Circulation

=78 cheryl stewart Patron registration Create Circulation

= J Profiles Patron registration Create express r... Circulation

- o Preferences Patron registration Delete Circulation

B {Pormissions <

Record Set Status

To support the ability to undelete a record set, record sets now have a status that is

stored as an additional column in the Record Sets table.

Record sets have a status of 1 = Final or 4 = Deleted.
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Record Set Undelete Transactions

To support the ability to track deleted or undeleted record sets, two new types of
transactions are now available in the Transaction Logging database table:

e Record set marked for deletion
e Record set undeleted

ministration Explorer - System - QA- .3 - Polaris -
Jl Administration Expl Systemn - QA-YODA 6.3 - Polari O X
File Edit Help
D-=2-H EY
Administration Explorer - System [ES] Transaction Logging
~-[E2] Did You Mean Overrid A
Geographic Coordinal s
Hold Request Statuse @ x| |
-] In-House IP Addresse ... Transaction Description Log Transaction ~
Item Block Descriptior % Econtent checkout (no item record) Yes
ftom Craate Call Num| o eCommerce Payment Yes
Item Create Price Hiet % Phone Attendant: Call Received v
-] Mobile Phone Carriers = one Attendant: Call Receive &s
[ Network Domains % System Logon Yes
-5 Object Locks % System Logoff Yes
Patron Address Types % Supervisor override transactions Yes
] Patron Name Titles & Record set deleted Yes
--[zz2] Postal Codes % d d
[ Primary Display Autho ; Record set create Yes
Primary Display Title ﬁ Record set modified Yes
=] STl CoTatio % Saved search has been run Yes
ransa{:tion Logging % Item barcode assigned to RFID tag Yes
- Sgﬁmm % Overdue notices posted Yes
EH---E’ Library % Patron barcode assigned to RFID tag Yes
Eg...._@ Branch | % Browse heading updated Yes
&F Collection % Record set marked for deletion Yes
(‘iﬁ Workstation N v % Record set undeleted Yes v
For Help, press F1 231row(s) D& cherylstewa

The following subtype data are included:

» 50 Type of Record

» 168 Record set RecordID
» 192 Record set owner

» 193 Record set name
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Record Set Status in Record Set Header and Properties in Staff Client

Record set status is now in the Record Set Header on Record Set Workforms for
Authority, Bibliographic, Item, and Patron record sets. Record sets can have a status of

Final or Deleted.

EE Record Set 84869 - Polaris
File Edit View Tools Help

DEHE-X

LEpS 57

Name: ‘ Serafina

‘ Owner: | cheryl.stewart

Note: ‘ Test Record Set

~ | Record type: | Bibliographic

Number of records: |2 Record status: | Final

G o |
Title Author Format  Linke... Holds  Public... Call Number Control N...  Status
iSerafina and the Black Cloak [electronic reso... Beatty, Robert Eaudio... 9 * 2015 1204816 Final
Serafina and the Black Cloak [electronic reso... Beatty, Robert  Ebook 6 * 2015 1328157 Final

L]
QO
W
2
o
Q
QO
x
a2
=
&
.y
=)
2
-
:__Q_.
o

The record set was saved successfully.

2 of 2 record(s) retrieved

Record set status is also now in Record Set Properties.
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Record Set Properties X

General About

Creator: cheryl.stewart
Creation date: 3/6/2019 2:55:02 PM
< Modifier:

Modification date:

g Record status: Final

Close

Undelete Menu Option and Icon for Record Sets

An Undelete menu option and icon are now available for all four record set types: Patron,
Item, Bibliographic, and Authority.

The Undelete Menu option is on the File menu directly below the Delete option. The
keyboard control for this option is Ctrl+ U.
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Anchor book of new I... Saratoga...
Anchor book of new I... Saratoga...
] Anchnr hnnl of now T Chilhaata

EE Record Set 34107 - Polaris

File Edit View Tools Help
New... Ctrl+N p HE E}%
Open... Ctrl+O |
CIOSG A|t+ F4 17Win7 - F 27
Save Ctrl+S
Print >
Delete Ctrl+D

I Undelete Ctrl+U |

Properties Fg Assigne... Collecti
Exit ... Saratoga...

What's New in Polaris and Leap 6.3

The Undelete icon is to the right of the Delete icon on the Record Set Workform.

EE Record Set 34107 - Polaris

File Edit View Tools Help

DEHSE - XX = & &%

Name: ‘ Retest47947Win7 - F_27

+J
()
(f) Note:

The Undelete option is only enabled if the record set's status is Deleted.

Find Tool Updated for Deleted Record Sets

The Find Tool in the Staff Client has been updated so that deleted record sets are
excluded from search results unless you search by Record Status or Record Set ID.

Record Status has been added to both the Cataloging Record Sets and the Patron
Services Record Sets Find Tools as access points for searches by Record Status:
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‘@ Cataloging Record Sets - Record status Find Tool — X
File Edit Tools Options Help
General Settings Scoping Branches Collections Databases
Search
Object: Record Sets ~ | Limit by: (None) - Search Mode
(®) Normal Stop
Search by: Record status ~ | Value: () Power
New Search
Type: Exact match (implicitly truncated) v O sQL
Clear
Sortby:  (None) v [ ] Count Only
Hel
For: ‘ ™ P
For Help, press F1 Stay on Select
@ Patron Services Record Sets - Record status Find Tool — x
File Edit Tools Options Help
General Settings
Search
Objedt: Record Sets ~ | Limit by: (None) &4 SEETEN L
(®) Normal Stop
Search by: |Record status ~  Valug: () Power
- . New Search
Type: Exact match (implicitly truncated) ~ OsaL
Clear
Sort by:  (None) ~ [ ]Count Only
Hel
For: | ~ ‘ 5
For Heln nress F1 Stav on Selact

The following access points in the Find Tool have been updated to exclude record sets
with the status of Deleted from these search results:

e Creation Date

« Name

e Owner

Record Set Status in Find Tool Search Results

Record set status is now available in data returned in the Find Tool search results.
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%] Cataloging Record Sets - Record status Find Tool — X
File Edit Tools Options Help
General Settings Scoping Branches Collections Databases.
Search
Object:  Record Sets ~ | Limit by: |(None) | SR
(® Normal Stop
Search by: Record status v Value: O Power
New Search
Type: Exact match (implicitly truncated) v OsaL
Sort by: > ("] Count Only e
T T Hels
For: deleted v =D
Item Record Mohawk Valley Library... 73 6/16/2005 Deleted
Elaine’s self-instruction es! - no kits Bibliographic Record Southern Adirondack ... 11/1/2005 For Polly to link to web site Deleted
New or overlayed subject authorities from LTI Authority Record Saratoga Springs Publi... 81564 10/21/2007 New or overlayed subject authorities from LTI - May .|  Deleted
Retest47947Win7 - F_27 Item Record QA-YODA 63 866 5/29/2012 Deleted

Record Set Status in Record Set Header and Info Properties in Leap

Record set status is now in the Record Set Header on Record Set Workforms for
Authority, Bibliographic, Item, and Patron record sets. Record sets can have a status of
Final or Deleted.

Bibliographic Record Set (i ] ACTIONS ~ C REFRESH FIRESULTS

Name Owner Record Set ID
Serafina cheryl.stewart v 84869
Note Record Status Record Count
Final 2

Record set status is also now in Record Set Properties.
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phic Record Set ©

RECORD SET PROPERTIES

RECORD SET ID: 84869

STATUS: FINAL

NAME: SERAFINA

CREATOR: CHERYL.STEWART

CREATION DATE: 3/6/2019 2:55:01 PM

MODIFIER: CHERYL.STEWART

ORI

MODIFICATION DATE: 3/6/2019 3:12:43 PM
| the Blac audi

Undelete Menu Option for Record Sets in Leap

An Undelete menu option is now in the header level ACTIONS button on all four record
set types: Patron, Item, Bibliographic, and Authority.

The Undelete option is only enabled if the record set's status is Deleted.

Bibliographic Record Set (i ] ACTIONS ~ ‘ C REFRESH GIRESUL

i Create Item Record Set

=E Create Authority Record Set

Elaine's self-instruction esl - no kits Southern Ag v 12(
& Export

Name Owner Reco

W Delete
Note Record Status puim Reco
4 Undelete

For Polly to link to web site Deleted — 21
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Find Tool Updated for Deleted Record Sets in Leap

The Find Tool in Leap has been updated so that deleted record sets are excluded from
search results unless you search by Record Status or Record Set ID.

Record Status has been added to the Find Tool as an access point for searches by
Record Status:

Find Tool - Record Set
Record Set » Basic Search » Record status » Exact »
(none) v m *
Record status
Deleted Repo
Final
»
Ready
Count Only CANCEL

The following access points in the Find Tool have been updated to exclude record sets
with the status of Deleted from these search results:

e Creation Date

 Name

e Owner

 Type
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Record Set Status in Find Tool Search Results in Leap

Record set status is now available in data returned in the Find Tool search results in

Leap.

A column called Record Status is now listed under Column Settings in the Find Tool.

This column is unselected by default.

Find Tool - Record Set

v Record Status

MOVE UP MOVE DOWN Display Position

Column Settings O
¢ Record Type Folded False
v Owner Name
v) Total Records Pinned
¥ Creation Date Visible True
¥ Note Width 10

The order of the column in the display.

Once selected, the column can be pinned and manipulated like all the other columns

under Column Settings.
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Find Tool - Record Set

Record Set » Basic Search » Record setID » Exact »

84728 m

Record Status

Record Type QOwner Total Records Creation Date Note

Final

2/25/2019 Test record...

Nest for Celeste Bibliographic R... cheryl.stewart

1 result(s)

Ready

Count Only m CANCEL
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Call Number and Volume on Hold and Almost Overdue
Notices

The item call number and volume are now included on Hold Notices and Almost
Overdue Reminders.

Both are added to each of the following notices after the Format column:

» Holds - Full-page mailer

» Holds - Half-page mailer

» Holds - Half-page mailer - dot matrix
» Holds - Z-fold mailer

» Holds - Z-fold oversize

e Email - Almost Overdue

» Email - AlImost Overdue Other Items
e Email - Reminder Almost Overdue

» Email - Request
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Circ Stats Added to Item View

The (YTD) circulation (circ) count and lifetime circ count stats are now displayed in the
Item Level view in the Bibliographic Records Preview window.

To view these stats:

1. From the Bibliographic Records Find Tool, right-click on a bibliographic record, and
select Preview.

N Bibliographic Records - Title Find Tool |;|i-
File Edit Tools Options Help
General ’Seth‘ngs | Scoping | Branches | Collections | Databases |
. L : - Search Mode
Object: |B|bI|Dgraph|c Records v | Limit by: ‘{None) .
(®) Normal Stop
Search by: |T|tie v I Value: () Power
®) New Search
Type:  [Exact match (mplicitly truncated) vl ~SQL [ New Search |
Sort by: I (None) v l [ count Only
For:  [doss v]
Title Author Format Lin.. Ho.. Publ.. Call Number Contr.. »
The dogs : a novel Calder, Robert. Book 2 1 1976  Fict Cal 4136
Dogs & dragons, trees & dreams : a collection ... Kuskin, Karla. Book 5 3 1980 J81MK 8554
Dogsled : a true tale of the North - 0 1976  917.98 Ran 10966
The dogs of Dewsbury e i 0 1976 821 A82d 17068 =
Dogs, breeding & showing. I 0 1983 636.7S 21805
Dogs. || Preview | o 183 e3P 23751
ADog's life: poems TPTInT L4 0 1983 J811Dog 26313
Dogsong. Add to Record Set » 0 1985 Fict Pau YA 29012
Dogs, dogs, dogs: a collection of great dog ca... 0 1985 741.5973Dog 33578
Dogs, all about them e | o 198 63675 35127
A dog's body Links » | 0 198 )599.744Col 35602
Dogs, dreams, and men Delete 0 1988 Fict Kau 49831
Dogs, dogs, dogs : the best of Beryl Chapple's ... Undelete (] 1984  636.7 Cha 51866
The dogs baTk : public pe‘o[.ale and private plac... T 0 1973 818C 56532 .
Namr s raloctione ~ae~ denimimes n 1071 EIETDAn VA ETANT
Done Stay on Select 28 of 417 record(s) retrieved Use

2. The Preview window opens. The (YTD) circulation (circ) count and lifetime circ
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count stats are displayed in the Item Level view.

76022211 /AC

0876911866 :$7.95 Display In PAC
AAXD512

Randles. Siim

Dogsled : a true tale of the North / Slim Randles

New York : Winchester Press, c1976.

209p.:22cm.

Areporter recounts adventures of his adopted life in Alaska and particularly his grueling dog team expeditions

Total number of active holds: Grand Total Circulation (ifetime): 19

Girc irc Girc
Branch Name YTD Lifetime
0
0
0
0
0

tals: 19
ayle Free Library (ARG)

Bancroft Public Library (Salem) (SLM)

Pember Library and Museum (Granville) (GRA)

Schenectady Branch - Central (SCP)

Assigned Bra... ~ Collection Material...  ShelfLo... Call Number Barcode Last Activit... ... | YTD Circ Count ~ Lifetime Circ Count.
. Argyle FreeL... AdultNon... Book 917.98 Ran 0002600073296  10/23/2007 e 0 5
. BancroftPubl... AdultNon... Book 917.98 Ran ithd... 0002200083398  4/1/2005 . 0 2
. PemberLibra... AdultNon... Book 917.98 Ran 0003200169799  3/21/2002 0 1
. Schenectady... AdultNon... Book 979.8R19 ithd... 0000400765061  7/20/2000 0 11

© 2022 Innovative (Part of Clarivate)
Page 43



What's New in Polaris and Leap 6.3

New Total Holds Thresholds Include Inactive Setting

In previous versions of Polaris, inactive hold requests counted toward a patron's total
number of allowed hold requests. As of Polaris version 6.2, a new system-level Total
holds thresholds include Inactive setting lets you specify whether inactive hold

requests count toward a patron's total holds limit.

The new system-level Total holds thresholds include Inactive setting is now available
on the Terms tab of the Hold options window. This window is accessible in the
Administration Explorer by selecting Parameters > Request.

Hold options

Mumber days held for pidup:
Default expiration period:

** Delete expired in:

*= Delete cancelled in:

*=* Delete not-supplied in:

== System level only

Days

10

35

33

35

Requests Charges Preferred Pickup  Staff dient & PAC Terms  RTF Queue

Undaimed requests:
(®) Delete
i) Cancel

** |./| Total holds thresholds indude Held/Shipped

== [ Total holds thresholds indude Inactive

Help

When the Total holds thresholds include Inactive checkbox is:

» Selected - Inactive hold requests count toward a patron's total holds limit. This is

the default setting.

» Not selected - Inactive hold requests do not count toward a patron's total holds

limit.
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New Patron Gender Options

New patron gender options now allow flexibility in how you track or don't track gender.

Gender Drop Down Menus

Patron registration workforms in the Staff Client, Leap, PowerPAC, and MobilePAC now
include Gender selection drop down menus.

All drop down menus start with a (None) option followed by a list of genders specified
for the specific organization. The (None) option is selected by default unless a patron
has already selected a gender. Selecting (None) sets the patron's gender to "null" in the
database as if they have opted out of a gender selection.

B

File Edit View Links

Patron Registration - 357715 - General - Polaris

Tools Help

_I:I-

c Barcode: | A12291954 | Registered at: |C0mmunity Library (COB)

'8 Last name: |Izquierda | Patron code: |Reh’red

E First name: |Laura | Instructor

E Middle name: | | Expiration:

2 rerm: [T ] ome
(=) Title: | v| Suffix: | erm I:v i el Ead
L

oy

5]
E
1]
+

[Joverdue

[[IHold
[illing

For Help, press F1

Female

b User defined fields

tatistical dass: (None)
stical dass NIA
assword: Male | 4

ID Number

Former barcode:

Birth date:

Last activity date:

[] Almost overdue/autorenew

|:| Patron record expiration

|:| Inactive patron

Maintain reading history

[ E-mail notices in plain text

[]Do not delete patron record

English vl Privileges | Restrictions
| 131335456456 | [+ 7]
12 11955 E~
| . Ay | Voter Registration

Date of original registration: | 11/15/2018 E~ | | Yes |
[ 6/18/2019 10:57:22 AM |

Cybraryl Use Only (000YYY)
Exdude from notices and reminders:
[T Exdude from collection agency |CPH W |

Not Currently in Use

[4
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LAURA IZQUIERDA ©

A12291954
@ COMMUNITY LIBRARY o BLOCKS

& Check Out {0y §iv Out (0) / Overdue (0) E5 Account (525.00) () Claims (2) / Lost (0) ™ Holds (12)/ Held (0) B3ILL (0) f Held (0) D Reading History 1 Associati

4 Profile
Profile
2 Atfributes
= Email Barcode * Registered At *
& Address A12291954 Community Library
* Phone:/Fax Former Barcode Patron Cods *
A Noifications 131335456456 Retired
2 Preferences
Last Mame * Drate of Registration
&l Image
lzquierda MA2018
O Misc. Info
First Hame * Expirafion Date *
Laura 112022
Middle Name Birth Date
1211955
Title Suffix Statistical Class
v Cobleskill-Town
Gender *
Female v
L] [ A
Female
Male
Kirottes
1D Mumber * Privileges / Resiriclions *
4 4
\intor Danictratinm * Tuhrarubl oo Dimbe 5O WL E

Manage Genders

A Genders Database table is available at the system, library, and branch levels. Changes
to the table modifies it for all users. Select Database Tables > Genders.
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P Administration Explorer - System - QA-YODA 6.3 - Polaris = || = -
File Edit Help
D= -H £
2
mﬂdministmtion Explorer - System EE]Genders
m Administration Explorer - System |
—ﬁ System: QA-Polaris =
----- % Parameters 2 =
----- 4 Profiles —
“4 Permissions - Description
..... B Securty ah N/A
* g': Pelisy—tabies &b Female
R abase Tables | & Male
e atierg-Sentrol )
----- Authority Deduplication ‘&' Bi-Gendered
-[E Bibliographic Deduplicatio & Cross Dresser
| Circulation Statuses & Transgender
| Computype Label Printer C & Trans Person
----- B erifean Ovenides & Man
..... =
----- [E=5 Geographic Coordinates ‘& ¥oman
----- Hold Request Statuses
-E5 In-House |P Addresses
| ftem Block Descriptions
| tem Create Call Number H
| tem Create Price: Hierarch
| Mobile Phone Carmiers
--E5 Network Domains
----- E= Ohiect | poks b
< mn >
For Help, press F1 9 row(s) B2 cheryl.stewar

Entries can be added/modified/deleted.

» A message is presented for changes that affect all libraries.

Polaris ILI

o Note:

Any changes to this table will affect all organizations,
even though the table was opened for a specific library or branch.

Save changes to the Genders table?

» Database integrity is enforced on the deletion, not allowing a user to delete a row
that is in use by a patron with the following message presented.

Polaris -

o Unable to delete the gender "Women'. Itis currently in use.
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Editing the Genders Table requires a new permission. Select Security > System
Administration > Modify genders table: Allow. This permission is granted at the Staff
Member, Workstation, and Permission Group levels. It is not granted by default.

P Administration Explorer - System - QA-YODA 6.3 - Polaris = = -
File Edit Help
&l Administration Explorer - System 2y Security
m Administration Explorer - System —l
—é System: QA-Polaris Seaurity
f E:j?lmeters Control Record Individuals With Permission
iles
f Permissions [ Remove Assign ¥
Ea = 4 +| (2] Modify fine codes table A
+ D Tables + 23 Modify fines table
+-{&] Notification Tables # (23 Modify floating collection limits
+G Server + (23 Modify floating material type |
+ﬁf Library + 23 Modify floating material types
+-{&) Branch i i i tabl
-85 Collection = 21 Madify genders table
----- BB Workstation 2 allow =
----- 52 Staff Member ST OGNy GEGaTapAI CooTaate
----- € Patron % (21 Modify hold status table
+ (23 Modify holds routing sequenc
+| 23 Modify import blackout times
+ 23 Modify initial articles table
# (23 Modify item availability display
+ 23 Modify item block descriptions
+1 [T Modifv item orice hierarchy t3
< m > <[ m >
For Help, press F1 B2 cherylstewar

You can also manage gender displays. These can be managed at the system, library,
and branch levels. Select Parameters > Patron Services > Patron Registration Filter
genders.
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File Edit Help
2 3
D2 H* & 1]
Administration Explorer - System 4% Parameters
-~ N -
2, Adiacent Test Lbrary selfCheck Unit : Credit Card Payment | NCIP
1» Amsterdam Acquisitions / Serials Patron Services Cateloging | PAC |  Motification
i Arafe t + ¢
il Ballston Spa
Parameter Value A
& Qutreach title rating enabled Yes
‘& Overdues: # of days until long overdue 20
& Overdues: Block for long overdue items Yes
- Security [E3 Overnight loan period Setup ...
-1 Policy Tables ‘& Patron Account: Charge Alert Threshold §999.00
i Database Tables [E3Patron delete options Setup ...
% :m:, '_::"5 [E3Patron message text: Configure Setup ...
mbridge e .
- i Canajoharie Patron me.ssagsj- text: E).(pl ration period 14 dayis)
---i,[}lesterto'.m (™3 Patron reaistratio on Setup ...
- [ Cifton Park
- i Cobleskil -Ratren-regisirationsribempaie
it Cf"'?"th ’ mQuick-circ: Material type
% [E):;:LLINEW [E3Reading history Setup ...
-8y Fonda E Registration fee options . . Setup ... >
i' Fort Edward < | m | ’ >
- e Fort Hurter e

ress F1 cheryl.stewai

You can select the gender options to display and change the order in which they are
displayed.

Current organization: Community Library (br)

Settings defined at: ‘& QA-YODA 6.3 (zys)
Select genders to display on the patron registration form:

[ maym

[v] Female

[ Male

[ Bi-Gendered
[] Cross Dresser
[ Transgender
[] Trans Person
|:| Man

] woman
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Gender Suppression

You now have the ability to suppress the Gender question when registering and opening
patron records. When suppressed, the Gender question will not be visible on patron
workforms, and gender is not tracked. Suppression is based on the patron's registered
branch.

To suppress Gender tracking in the Staff Client and Leap, select Branch > Parameters >
Patron Services > Patron registration options.

P Administration Explorer - Branch - QA-YODA 6.3 - Polaris = |0 X
File Edit Help
N-=-d EY
mAdministlation Explorer - Branch =% Parameters
+-f@ Adjacert Test Branch Two | A - -
+ Amsterdam Free Library - SelfChed: Unit : Credit Card Payment I NCIP
+ frayle Free Library = Acquisitions | Serials Patron Services | Cataloging PAC | Notification
+-fay Ballston Spa Public: Library
+ Bancroft Public Library (Salem
+ Bolton Free Library Parameter Value ~
+ Bumit Hils - Town of Ballston ( [BIORS reading history Setup ...
+ Cambridge Public Library & ORs: automatically print packing list No
+f8) Canajoharie Library B ORs: Include other library items in selection list ing N
£-18) Chester Public Library, Town ¢ : Include other library items in selection list processing  No
+ Children's Hospital Library mORS: Prompt for update during normal check-out Yes
: ; n Public | 8} Outreach title rating enabled Yes
= Community Library % Overdues: # of days until long overdue 20
Parameters & Overdues: Block for long overdue items Yes
Pemissions [E3 Overnight loan period Setup ...
B Secuity &Patron Account: Charge Alert Threshold §999.00
,:,.. Palicy Tables [E3Patron delete options Setup ... -
- Database Tables [E3Patron message text: Configure Setup ...
Collection : Exniration period 14 day(s)
Workstation Patron registration options Setu
+--ir2 Staff Member b J F [zaz
" Patron Epatron Reg.lstrai.:lon. Flher genders Setup ... o
.- Corinth's Frae | ihrane hd < o T - |||- ' o 3
£ m >
For Help, press F1 S cherylstewar

Select Display Options. When Gender is checked, it is suppressed.
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Patron registration options -

| General defaults I Data Field Defaults | Display Options |

Required field options
[ address
[Birth date

Gender
[Prassword

[ statistical class

Fields to suppress

Gender

| Save | | Cancel | | Apply | | Help |

To suppress Gender in Self-registration, select Branch > Profiles > PAC > Patron access
options.

P Administration Explorer - Branch - QA-YODA 6.3 - Polaris =|8] X
File Edit Help
N-=-d A
mﬂdministmtion Explorer - Branch 28 Profiles
+-18 Adiacent Test Branch Two | - - - ; -
+1-18), Amsterdam Free Library — Children's PAC Staff Client | Mobile PAC # Community
+ Argyle Free Library = Acguisitions / Serials Patron Services | Cataloging | PAC PowerPAC
+|-{8) Ballston Spa Public Library "
+-{8) Bancroft Public Library (Salem
+ Bolton Free Library Profile Value ~
+ Bumt Hills - Town of Ballston ( B8l item availability: Display due date in detailed item status ~ Yes
+ gamb.n:ge. Pﬂbbhc Library &Item availability: Display shelf location Yes
- anajoharie Library P
+ Chester Public Library, Town ¢ mltem avaﬁlabflft}r. Dfsplay status Yes
+ Children's Hospital Library mltem availability: Display type Yes
+-1&@ Clifton Park-Hafmoon Public L Item availability: Suppress for integrated econtent titles Yes
(=1 t@y Community Librafy r“‘||\,1..|+;l.-.| lansuiane ctrimne Setup ...
. [E3Patron access options Setup ...
atron access: hsplay hold queue information Mo £
mPatron access: Policy statement hyper text link
Policy Tables m Patron access: Policy statement hyper text link permitted  No
Database Tables [EPatron access: Renewal Setup ...
-4 Collection [E3Patron eReceipts Setup ...
B i
: ';sé g;:(aambn &Patron library assigned and free text block default text Library assigned block
+-F2 ember
i é Patron Patrons can r.emove reading history Yes o
.- fir_Corinth's Free | ihrane hd £ - ’ m o >
< m ¥
For Help, press F1 B2 cherylstewar

Select Self-registration. Gender is suppressed when Suppress gender selection is
checked.
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Patron Access Options [ Community Library (br) ] =
Self-registration |Defaults I LogIn I Contact Info I Preferences I Ask us |
Patron can selfregister
E-mail to: [ add || Deete |
MName Branch
Cobleskill Patron Update Community Library
Self-registration warning message enabled
Selfregistration Instruction, Acknowledgement, and COPPA
messages are defined on the Display Names and Message Text
dialog box (Double-dick 'Multiple language strings').
UUDF Display | Custom Field Display
User defined fields to display
11D Mumber Required
Privileges / Restrictions [required
|:| Voter Registration Required
[cybraryN Use Only (XX, YY) Required
[Inot Currently in Use Required
Birth date required
[ suppress gender selection I
I Save I Cancel Apply

What's New in Polaris and Leap 6.3

Gender No Longer Copied During Copy Patron Operation

Copying a patron record will not copy over the gender but should use the same
suppression rules unless/until the patron's registered branch changes.

Important Notes About Staff Client Offline Registration and Automated Offline

Upload

» While uploading offline transactions, specifically offline patron registration, using
Bookmobile or Automated Offline, the upload process will try to convert the exist-
ing single character gender (N, F, M) to the new GenderID values.
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» The new GenderID mappings are allowed to be deleted, but if the library plans to
do so, then they MUST keep them until ALL offline transaction files created on
releases older than 6.3 are uploaded.

» Once the library starts doing offline circulation on a 6.3 or newer staff client, they
can remove the default gender entries if they choose to do so, but they will not be
able to maintain a gender when uploading transactions from a previous release.

Important Notes about INN-Reach

The gender in the virtual patron record is set from the gender in the institutional patron
template. If the registered branch of the virtual patron is not set to display the gender in
the template, the gender of the virtual patron will be set to (None). The INN-Reach
gender applied to the institutional patron template should be a gender that is available
at all branches.

Important Notes about SimplyReports

Any saved reports that used the Gender field will now be broken. To fix these:

1. Open the report for editing.
2. Verify your Gender selection is still valid.
3. Save thereport.
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Suspend and Resume Outgoing Circulation APl Mes-
sages for INN-Reach

Suspend and Resume buttons were added to the Current Queue Status section of the
Status and Statistics page in Polaris INN-Reach Administration. These buttons provide
the ability to suspend and resume outgoing circulation APl messages. You must have

the INN-Reach Modify user permission to use this feature. Otherwise, the Action column
and the buttons do not appear.

When you select the Suspend button, the Resume button appears.

Polaris to INN-Reach  Home  Status ~

Status and Statistics
The INN-Reach statistical data listed below applies to this local Polaris site.
Local Server Status

Good news! Local system is configured and running J
show details
Current Queue Status
Count  Acti
0
0 [suspend
Record Contribution Statistics
Action thour 24hours 7days 30days  Lifetime
Bibliographic records contributed to INN-Reach 0 0 0 1 18469
Bibliographic records updated 0 1 7 7
Item records uted to INN-Reach 0 0 0 1 22210
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Additional Item Columns Added to Request Manager

You can now view Item Agency and Item Location information directly in the Request

Manager. This ability is available in both the Staff Client and Leap. This information was
previously only visible by opening each request and viewing the Notes field. The
function of the Notes field remains unchanged; information will still display in the Notes

field.

Customers must be licensed for INN-Reach in order to view the new columns.
Customers who don’t use INN-Reach will not see the additional columns.

Staff Client View

File View Tools Help

2 & - 2

9

Request Manager - ILL Requests

BE

For Help, press F1

-
[«}] Branch name: lCommumtv Library (COB) v| By: |Pickup VJ Status: {Shipped v
=)
g Requests
(40 ] Date Author Title Item Agency  Item Location Format Patron Name Shipped Dat)
E 6/18/2019 Watson, Nanc... The birthday goat. ... |plagc DML 3rd Floor Books SoundR.., InnReach, Siste... 6/18/2019
i 6/18/2019 James, Henry,... The turn of the scr... |plagd Pitkin Non-Print Colle... | Book InnReach, Loga... 6/18/2019
U) 6/18/2019 Underwood, M... Double jeopardy [I... [plagd Norlin Library--Stacks | Book InnReach, Loga... 6/18/2019
Q 6/18/2019 Wiliams, Ursul... The Three toymaker.. |plagg Corinth's Free Library | Book InnReach, Loga... 6/18/2019
=y 6/18/2019 Williams, VeraB.  The great watermel... Jplagc Broomfield MDE Non-.. | Book InnReach, Siste...  6/18/2019
o
g
< m >
Number: 5 RTF: Jun 212019 5:00AM NUM

Leap View
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Request Manager crerrest [

Branch Community Library (COB) v Status Shipped v| By Pickup ¥

wHolds  ESILL  EAINN-Reach

Total items | 5 total

DATE AUTHOR TITLE ITEMAGENCY  ITEM LOCATION FORMAT PATRON NAME SHIPPED DATE
6/182019 Watson, Nancy The birthday goat. Pictures by Wendy plage DML 3rd Floor Books | Sound InnReach, SisterYoda 6/18/2019
Dingman Watson Recording CommunityY-MVLS
6/18/2019 James, Henry, The turn of the screw [large print] / Henry plagd Pitkin Non-Print Book InnReach, Logan 6/18/2019

1843-1916 James. Collection C576 Community Yoda-MVLS
6/182019 Underwood Double jeopardy [large print] / Michael plagd Norlin Library--Stacks | Book InnReach, Logan 6/18/2019
Michael, 1916- Underwood Community Yoda-MVLS
6/18/2019 Williams, Ursula The Three toymakers / lllustrated by Shirley plagg Corinth's Free Library | Book InnReach, Logan 6/1812019
Moray, 1911- Hughes. Community Yoda-MVLS
6/182019 Williams, Vera B. The great watermelon birthday / Vera B. plage Broomfield MDE Book InnReach, SisterYoda 6/18/2019
Williams. Non-Fiction CommunityY-MVLS
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Support for JetPay E-commerce in Polaris PowerPAC

You can now use the JetPay gateway to accept credit card payments from Polaris
PowerPAC. JetPay is a hosted method of accepting credit card payments from
PowerPAC. You can enable the use of JetPay at the system, library, or branch level.

When you use JetPay for payments, JetPay handles much of the responsibility of
Payment Card Industry Data Security Standard (PCI DSS) compliance for your library. No
credit card information is stored in the Polaris database when a payment is made via
JetPay.

Note:
The use of JetPay for payments from the staff client, Polaris
ExpressCheck, or Mobile PAC is not supported.

To enable JetPay e-commerce, you must:

1. Set up a JetPay account

2. Set up JetPay processing in the Administration Explorer

Set Up a JetPay Account

To enable the use of JetPay for accepting credit card payments from Polaris PowerPAC,
contact JetPay to establish an account for your library.

When establishing your library's JetPay account, make a note of the following two
pieces of information:

e Client key
» Web key

You will need this information to set up JetPay processing in the Administration
Explorer.

Set Up JetPay Processing in the Administration Explorer
To configure Polaris to use JetPay for processing credit card payments from

PowerPAC:
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1. Inthe Administration Explorer tree view, navigate to the organization for which you
want to enable JetPay processing, and click Parameters > Credit Card Payment.

2. Double-click Online Payments: Configure.

The Online Payments Settings dialog box opens.

Online Payment Settings

Payment processing gateway

| JetF'.ay| e Properties

PowerPAC  staff Client fLeap ExpressCheck Mobile PAC

Allow online payments

Minirnum fine ($):

0,00
Send email receipt

] cisplay privacy policy

[ isplay refund policy

[ ] allow donations

Allow patron to designate title purchase

Cancel Help

3. Inthe Payment processing gateway list, select JetPay.
4. Click Properties.

The JetPay dialog box appears.
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JetPay >

Connection

Transaction LIRL:

Payment page URL:

Transaction fee URL:

Client key:

Web key:

PAC return URL:

| |
Post-back URL: | |
| |
| |

Donations PAC return URL:

Library absorbs fees: ]

Cancel Help

5. Enter the following connection information:
a. Transaction URL - Enter the following URL:

https://magic.collectorsolutions.com/magic-api/api/transaction/redirect
b. Payment page URL - Enter the following URL:
https://magic.collectorsolutions.com/magic-ui/PaymentRedirect
c. Transaction fee URL - Enter the following URL:
https://magic.collectorsolutions.com/magic-api/api/fee

d. Client key - Enter the client key provided when your library set up a JetPay
account.

e. Web key - Enter the web key provided when your library set up a JetPay
account.

f. Post-back URL - Enter the post-back URL for your site, using the format
below:
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https://<www.mylibrary.org/polaris>/payments/PostbackJetPay.aspx

Note:
Replace <www.mylibrary.org/polaris> with your Polaris
PowerPAC URL.

This field accepts a maximum of 250 alphanumeric characters.

g. PAC return URL - Enter the URL that will be displayed when the user clicks
the return link on the JetPay final payment transaction page. To use your lib-
rary's PowerPAC patron account Fine & Fees page, use the format below:

https://<www.mylibrary.org>/polaris/patronaccount/finesfees.aspx

Note:
Replace <www.mylibrary.org/polaris> with your Polaris
PowerPAC URL.

This field accepts a maximum of 250 alphanumeric characters.

h. Donations PAC return URL - If you plan to accept donations, enter the URL of
the Polaris PowerPAC page that will be displayed when the user clicks the
return link on the JetPay final payment transaction page. This field is
required. If you do not plan to accept donations, simply enter your PAC
Return URL. This field accepts a maximum of 250 alphanumeric characters.

i. Library absorbs fees - Select this checkbox if you want the library to absorb
the JetPay credit card processing fee. This checkbox is a shadow setting of
how your account is set up in JetPay to display warnings and fees to the pat-
ron and it must match the corresponding setting in JetPay. If this checkbox
is not selected, the processing fee is billed to the patron.

j. Click OK.
6. Configure the following settings on the PowerPAC tab of the Online Payments Set-
tings dialog box:
a. Allow online payments - Select this checkbox to enable the use of JetPay for
credit card payment processing.

Note:
In PowerPAC, patrons pay fines on the Fines and Fees page of
the patron account. Be sure the PowerPAC profile Navigation:
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Fines & fees is set to Yes for the organization to allow patrons
to access this page. For more information, see Enable patron
account access - PowerPAC.

b. Minimum fine - Enter the minimum fine amount that will be accepted via
credit card payment. The default value for this setting is $1.00.

Note:

If the amount a patron owes is less than the Minimum fine
value, the Pay fines link does not appear in the patron's
account in Polaris PowerPAC.

c. Processing fee -This is controlled completely by JetPay and should be set up
there. To charge a processing fee for fine payments, enter an amount in the
Processing fee box. The maximum value for this setting is $20.00. The
default value is $0.00.

d. Display privacy policy - To display a privacy policy link in Polaris PowerPAC,
select Display privacy policy. For more information, see Privacy and Refund
Policy Display Options.

e. Display refund policy - To display a refund policy link in Polaris PowerPAC,
select Display refund policy. For more information, see Privacy and Refund
Policy Display Options.

f. Allow donations - Select this checkbox to enable the use of credit card pay-
ments for donations.

g. Processing fee - This is controlled completely by JetPay and should be set
up there. To charge a processing fee for donations, enter an amount in the
Processing fee box for donation payments. The maximum value is $20.00.
The default value is $0.00.

h. Allow patron to designate title purchase - Select this checkbox to allow the
donor to direct a donation toward a title purchase in a specific subject area.
When this option is selected, the donations page includes a field where the
donor can specify a title purchase.

7. Click OK to save your settings.
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Display Improvements in Polaris PowerPAC

Item availability information in the PowerPAC user interface has been improved to
reduce horizontal scrolling. This change makes it easier for users to navigate Polaris
PowerPAC using mobile devices.

Tablets will display item availability information in a table format similar to that on a PC.

Phones will display item availability information in a list.
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Multilingual Support for Dashboard Titles

If your library is licensed for additional languages in the PAC, you can now view
dashboard labels in a language other than English, and the labels can be customized.
Previously, when a different language was selected, the dashboard labels would
continue to display in English. Labels can now appear in the language the user selects if
the database contains the appropriate translation.

Two dashboard types can be configured: Polaris PowerPAC dashboards and customer-
defined dashboards. The following sections describe how to customize each
dashboard.

Customize the Polaris PowerPAC dashboard

Each of the Polaris-defined dashboards now have a system-assigned mnemonic that
can be used to edit the dashboard's default title. You can view a dashboard’s mnemonic
in the properties box that opens when the dashboard label is double clicked.
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Web Part Editor x

Polaris and 3rd Party | User Defined

'_u-‘u'eb Parts: Polaris - _

Children's Fiction Series
Children's Illustrated

Early and Middle Grade Ru Make a3 Donation
Hardcover Fiction 0

Hardcover Non-Fiction .
Mnemenic:
Mass Market
Most Circ'd Authors PACML_DASH_DONATION
Most Circ'd Subjects
Most Circ'd Titles
New Titles

[P Medar Thmenn

oK

Total Listing Rows
0

OK Help

To change a mnemonic, edit the strings associated with that mnemonic in WebAdmin.
The following table lists new mnemonics and associated values that can be used with
multilingual support.

Mnemonic Value

PACML_DASH_CHILDFICTIONSERIES || Children's Fiction Series
PACML_DASH_CHILDILLUSTRATED || Children's lllustrated

PACML_DASH_DONATION Make a Donation
PACML_DASH_EARLYMIDDLE Early and Middle Grade Readers
PACML_DASH_HARDFICTION Hardcover Fiction
PACML_DASH_MASSMARKET Mass Market

PACML_DASH_MOSTCIRCAUTHORS || Most Circ'd Authors
PACML_DASH_MOSTCIRCSUBJECTS || Most Circ'd Subjects
PACML_DASH_MOSTCIRCTITLES Most Circ'd Titles
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PACML_DASH_NEWTITLES New Titles
PACML_DASH_ONORDERITEMS
PACML_DASH_PAPERFICTION
PACML_DASH_PAPERNONFICTION

PACML_DASH_YOUNGADULT

On-Order Items

Trade Paperback Fiction

Trade Paperback Non-Fiction
Young Adult

Some dashboards are not listed. They already have mnemonics that allow them to be
customized in WebAdmin. These dashboards are listed in the table below.

Mnemonic Value

PACML_HEADER_1007

Patron Account

PACML_FEATURE_DASHHEAD

Feature It!

PACML_DASHBOARD_XSL_1551

Title Lists

PACPROF_NARROW_DASH_LABEL (multilingual SA
string)

Narrow Search

PACPROF_RELATED_DASH_LABEL (multilingual SA
string)

Related Searches

ACPROF_NARROW_DASH_LABEL (multilingual SA
string)

Narrow Community
Search

PACPROF_RELATED_DASH_LABEL (multilingual SA
string)

Related Community
Search

PACML_DASHBOARD_XSL_1558

Saved Searches

PACML_RVT_DASHHEAD

Previous Titles

Customize a customer-defined dashboard

You can now associate a multilingual mnemonic with user-defined dashboard labels.

When creating a new user-defined dashboard, specify a mnemonic along with a default
title. Mnemonics should not contain spaces.
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), Web Part Editor X

‘ Polaris and 3rd Party | User Defined ‘

Web Parts: Add Web Part Title

Best Sellers Title: Add
Easter Titles e
Help Back to School Suggestions Edit
Hours

Kellie's list
Ms. Stacey Recomme| Mnemonic (optional):
New Graphic Titles

New Popular Titles DASH_BACKTOSCHOOL
OverDrive titles
Summer Holiday Picnid oK ‘ ‘ Cancel ‘ l Help

Summer Reading List

Lo |

» Mnemonics are optional. If multiple languages are not used in PowerPAC, a mne-
monic does not need to be specified during dashboard creation. The dashboard
title will only display what is entered in the dialog box “Title” field.

« A mnemonic is only specified when creating a dashboard. To add a mnemonic to
an existing user-defined dashboard, the old dashboard must be deleted and a new
one created. When the new dashboard is created, a mnemonic can be specified.

Strings for each language are created automatically with the title specified as the
default display value for the mnemonic. The title label can then be edited for each
language using the mnemonic in WebAdmin.
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Configure the Maximum Length of the Title Summary in
PowerPAC Search Results

The new PowerPAC profile Title Display: Number of characters in the Summary (Short)
allows you to specify the maximum number of characters of the Summary (Short) field
that are displayed in the brief and full search results views for a title in the Polaris

PowerPAC.

m Administration Explorer - System
File Edit Help

h-=-H

mAdministration Explorer - System

ER

28 Profiles

—I-f&) Branch

{8 _Test Branch 1 (Library 8)
+ Adjacent Test Branch One
-8t Adjacent Test Branch Three
- f@) Adjacent Test Branch Two
- f@ Amsterdam Free Library
{8} Argyle Free Library

(&) Ballston Spa Public Library
+ Bancroft Public Library (Salem
+ Bolton Free Library

- g8t Bumt Hills - Town of Ballston ¢
-8t Cambridge Public Library
{8 Canajoharie Library

-8} Chester Public Library, Town ¢
- f@t Children’s Hospital Library

- f@ Clifton Park-Halfmoon Public L
Community Library

: % Parameters

Far Help, press F1

-~

Acguisitions [ Serials  Patron Services Cataloging  PAC

Profile

[E3Remote databases: Categorization of target databases

mRemote databases: Maximum number that can be searched at once
[E3Remote databases: Usage settings

m Remote user PowerPAC: Enable

&Result set: Maximum number of records to return

&Rotating best seller book jacket on Portal page

B8 R55 Feeds: Enable

mScoping: Use MARC language scoping display table

18} Search options: Limit by collection enabled

18} Single login: Enable

mText: Headings count column for “see from" headings
{8 Theme dashboard position

{8} Theme selection

PowerPAC  Children's PAC  Staff Client  Mobile PAC

éSearch: Display search criteria in search box for link-produced searc...

Value
Setup ...
10

Setup ...
Yes
100000
Mo

Title Display: Confiqure
mTitIe Display: Mumber of characters in the Summary (Short)
Title list: Email

&b Title list: Enable

&) Title list: Enable bulk holds

&Title list: Maximum number of titles to request in bulk
I8l Title list: Print

mTitIE list: Save

<i

B2 emily.reisinger

Community

¢ &

~

By default, this profile is set to "0", and the number of characters displayed is not
limited. You can enter a value between 0 and 4000.

When Summary field text exceeds the specified limit, Polaris PowerPAC displays
truncated summary text followed by a More link. Users can click More to expand the
display to show the entire summary, and click Less to collapse the display again.
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Tirs ] 3. The first moon landing AVAILABILITY
Ly 'ﬁ”“hm by Kortenkamp, Steve.
. X E FULL DISPLAY
... Dreaming of the moon— The space race — Practice makes perfect —
Apollo 11 - Going to the moon - Landing on the moon— Exploring the E PLACE REQUEST

moon— Coming home — Amazing .

Summary: Describes the first fanding on the moon. including Add to My List
information about the ...More

2008
Publisher, Date: Mankato, Minn. : Capstone Press, ®2008.
M Description: 24 pages : illustrations (chiefly color) ; 22 cm.
Lexile: 670 Series: First facts. Solar system.
User rating K
LL Target Audience Note: 2

Rate or review

w Add to Shelf

add a review

Google

Preview
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Compile CSS File with Polaris Web Admin Tool

An option to compile custom CSS for custom themes has been added to the Polaris
Web Admin tool for hosted libraries without direct access to the PowerPAC server.

The new option is found under PAC Tools > Compile CSS:

Polaris Web Admin Tool

Language Tools PAC Tools || PAPI Key Management [ Help

Reload | Compile CSS | Identify String  Log Off

When a site has at least one custom theme, a table similar to the PAC reload is
displayed:

Reload Compile (55  Identify String  Log Off

PowerPAC Server Custom Theme Status

ompile 'MVLS' theme | Theme not yet compiled

'a)

https://rd-polaris.polarislibrary.com/polaris/

ompile 'BCPL' theme Theme not yet compiled

'a)

ompile 'Rube’ theme Theme last compiled: 1/24/2019 3:34 PM

'a)

ompile 'MVLS' theme | Theme not yet compiled

'a)

http://rubenau-It.iii.com/polaris

'a)

ompile 'BCPL' theme Theme not yet compiled

a)

ompile 'Rube’ theme Theme not yet compiled

The table contains:
o PowerPAC Server - the names of the servers on which the custom themes are
compiled.

e Custom Theme - the name of each custom theme found on the server. The name
is clickable and executes the compile/recompile action on click.

« Status - the status of the compile. This column will display one of the following:
o Last date/time the theme was compiled successfully
° Theme not yet compiled
o Compiling
o Compile failed with any error details
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http://QA-Polaris.polarislibrary.com/polaris/ Compile '"MVLS' theme | Theme last compiled: 4/24/2019 1:22 PM

Compile 'BCPL' theme |Theme not yet compiled |

Compile 'Responsive Test' theme | Compiling ...

http://rubenau-Itiii.com/polaris Compile

Compile

Compile

MVLS' theme | Theme not yet compiled

Compile failed
BCPL' theme File: "G:\Projects\Dev\Software\sro\PowerPAC custom\themes\bepliscss\style-
beplscss' not found on server

Rube' theme Compile successful

When the site does not have custom themes, the page will display the following

message:

| O~ S

No custom themes found.

Polaris Web Ad

Language Tools PAC Tools
Reload Compile C88  Identify String Log Of
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Security Improvements for Patron Password Workflows

Polaris 6.3 contains updates that improve security for patrons who create or reset the
password for their library account from Polaris PowerPAC, Mobile PAC, or
ExpressCheck.

In previous versions, a patron could request a new password by clicking a Forgot your
password? link in either Polaris PowerPAC, Mobile PAC, or ExpressCheck. The library
would then send a new password to the patron in an email message.

If a patron had a library account but had never created a password for the account, the
patron could create a password by clicking a Create a password link in Polaris
PowerPAC, Mobile PAC, or ExpressCheck.

In Polaris 6.3, a patron who wishes to create or reset a password can click a link in
Polaris PowerPAC, Mobile PAC, or ExpressCheck and receive an email containing a
time-sensitive link to a Reset Password page where the patron can configure a new
password. Libraries can use the new Reset password link timeout duration setting to
specify the time period during which the time-sensitive password reset link remains
valid.

Patron Workflow for Creating or Resetting a Password

Configuring the Reset Password Link Timeout Period

Other User Interface Changes

Patron Workflow for Creating or Resetting a Password

Patrons can use the workflow described below to reset a library account password or
create a password for the first time in Polaris PowerPAC or Mobile PAC.

To reset or create a password:

1. In Polaris PowerPAC, select Log In at the top of the page or Log In/Register from
the My Account menu. In Mobile PAC, click the My Account link. Or, in
ExpressCheck, scan your barcode or select Forgot your library card? Press here!.

The Log In page appears.
2. Click the Forgot your password? link.

A Reset Password page appears.
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3. Enter your user name or barcode in the Username or Barcode box.
4. Click Submit.

Your library sends an email to the email address associated with your library
account.

5. Open the email and click the provided reset password link.
A Reset Password page opens in a new browser window or tab.

6. Enter your new password in the New Password box.
7. Enter your new password in the Confirm Password box.
8. Click Submit.

A confirmation message appears, and your library account is updated with your
new password.

Configuring the Reset Password Link Timeout Period

A new Reset password link timeout duration profile setting is now available on the
Profiles > PAC tab of the Administration Explorer.

This setting determines the time period (in minutes) during which the reset password
link emailed to the patron remains active. The setting is available at the System, Library,
and Branch levels. You can enter a value between 1 and 999 minutes. By default, the
timeout period is set to 60 minutes.

If a patron clicks the reset password link after the active period has elapsed, a Reset
Password page appears. The page notifies the patron that the reset password link has
expired and prompts the patron to request a new one by entering a library user name or
barcode.

The nightly Patron Processing SQL job removes reset password links after the specified
active period has elapsed.

Other User Interface Changes

In the Administration Explorer, the Display prompt for new password setting no longer
appears on the Log In tab of the Patron Access Options profile. This profile setting is no
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longer needed; a patron with an existing library account who has never created a
password can create one using the workflow described above.

Updated E-mail Forgotten Password Label

The label for the optional system email forgotten password feature has been updated.
The label is now called E-mail reset password link.

To access the feature in the Administration Explorer, go to Profiles > PAC > Patron
Access Options > Login:

Patron Access Options [ QA-YODA 6.3 (sys) ] -

| Selfregistration | Defaults | LogIn |Con13ct Info | Preferences | Ask us |

Staff can override password S sad -
CPH Resident
nable staff override etire
[ Enable staff icl [v] CPH Retired
CPH 5taff { Board
PAC override password: Delinquent Borrower =
17345 ILL Agency
Juvenile
uvenie wi esmicuons
Juvenile with Restricti
Enable patron username New Borrawer
Outreach
E-mail reset password link Regular
Retired
. Saratoga Outreach
" aratoga Residen
[[]Passwords must be numeric only Saratoga Resident
Saratoga Staff [ Board
Schenectady resident v

Save | | Cancel Apply
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Leap Offline

Permission based Leap Offline is now available for circulating materials while your
database server or network are unavailable. Each Windows user will have a unique
installation of Leap Offline for each browser they use. Installation of the application is
initiated through Leap and should be bookmarked for future use. The application uses
the local storage features of your browser to store limited installation data that is
required to process offline transactions. No patron data will be stored locally.

The Leap Offline application is shown below:

£ Settings & Print
Offline Check Out

A12291954

Enter item barcode o O special Loan

Item Barcode Due Date

0000101521664 7/10/2019
0000203269816 7/10/2019

Offline transactions are stored in the local storage of the user's browser until the user
chooses to send them to the server for processing or to delete them.

As you work in Leap offline, you will see your transaction count increment with each
check out. The Transactions badge will keep you informed of your progress.

Username: cheryl.stewart Organization: Community Library

$# Settings & Print

Selecting the Transactions badge will open a dialog showing all the offline transaction
files you have generated, with an option to delete them. You should only delete

© 2022 Innovative (Part of Clarivate)
Page 74



What's New in Polaris and Leap 6.3

transaction files you created while training or testing. Deleting files cannot be undone.

My Offline Files .
Filename Transactions
PTF_2019062616143871_STEWART-LT.TRN 1

| understand that deleting files cannot be undone.

Delete All Files ‘ Cancel ‘

New Permission for Leap Offline Setup

A system administration permission to control which users can complete the Leap
Offline installation is now available. Select Security > Leap > Setup Offline > Allow.
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7] Administration Explorer - System - QA-YODA 6.3 - Polaris =19 .
File Edit Help

D-=-H K7

B8 Administration Explorer - System 2y Security

m Administration Explorer - System "
. 5
-é System: QA-Polaris e
5 Parameters Control Record Individuals With Permission
an 0 B Remove Assign -
L +] . Acguisitions HAdminish’amr -~
. Tables + @ Cataloging Wl -
N
+-if] Notification Tables + @ Circulation B2 chris.Javenture
@ Fublic Access Catalog 2 marycay.phelps
+ Serials @ m
] System Administration @ A Cocca
# @ Find Tool &) ams102
+ & Polaris Fusion 8 ams 103
----- 52 Staff Member = @ Leap ams
""" & Patron # 20 Access Leap 8pams12
+ [Z7 Access Leap remotely @ ams20
= 21 Setup offline & ams21
f T Sz
@ ams 7400
@ Andy Hoag
BB Anik Gibiau hd
< m b
For Help, press F1 B2 kellie.conner  NUM

» This permission is not assigned at upgrade.
» Workstation access is permitted by default.
e The permission is not overridable.

Web Browser Information for Leap Offline

The following browsers are compatible with Leap Offline:

» Windows Chrome v74.0.3729.157+

» Windows Edge v44.17763.1.0+

» Windows Firefox v66.0.5+

o OS X Safariv12+

e OS X Chrome v74+

« i0S Safari 11.3+ (eg: iPad 5th+, iPad Air+)

Incompatible browsers:

« Windows Internet Explorer (all)
» i0OS Safari 1.0-11.2
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Leap Offline Installation

You must have the Leap Offline permission enabled and use a compatible web browser
to install the application.

1. If Leap Offline has not been previously installed, you will see an installation Warn-
ing icon. To install, select the Warning icon:

New ¥ Utilities ¥ Help ¥ I ¢ neryl.stewart (COB)

= PRINT

2. Select Install Offline:

9 cheryl.stewart (COB) =

£ Settings
& Clear Cache

C Refresh Permissions

! Install Offline

® Logout

3. You will see the following message:

—

Installing offline files...
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4. Select Leap Offline.

Offline setup has been completed for your user/workstation.

Please navigate to and create a bookmark.

5. Leap Offline will open in the browser.

> O @ https://qa-polaris.polarislibrary.com/leapoffline/#/checkout

3 ol Mail - cherylstewar... Confluence links Flare and Capture Netsuite Dropbo

Bookmark added

hp Offline Work S ine]

& Check Out Folder Confluence links
More... m Remove

Offline Check Out

Enter patron barcode

Note:
The URL used to access Offline is case sensitive, and you should create a
bookmark for it to access the Leap Offline application for future sessions.

Note:

Offline data (both setup data AND actual transaction data) is stored in the
local storage of the user's browser. You should not clear your cache while
you have unprocessed offline transactions.

Refresh Leap Offline Installation

You have an option to update your Leap Offline installation with any changes made to
system administration without manually clearing your cache and re-installing the
application.
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This option is found in the Leap application. Select User Profile > Refresh Offline
Installation.

tilities Help * 2 cheryl.stewart (COB) ~

¥ Settings
& Clear Cache

C Refresh Permissions

C Refresh Offline Installation

® Logout

Refreshing the installation updates the following values:

e UserlID

e User Name

» Workstation ID

» Workstation Branch ID
» Workstation Name

e BranchID

» Standard Loan Period
» Branch Name

» Branch Phone

e Branch Home Page

e Branch Receipt Note
» Locale Name

Leap Offline Settings

The Settings workform in Leap Offline has several options.
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Select Print Options to enable Check Out receipt printing for patrons. This selection is
persistent unless the cache is cleared.

& Settings & Print
Settings

& Print Options Q@ Special Loan [E] Workform Defaults # Installation

Check out

¥ Check out receipt

Select Special Loan to set a special loan period that applies to all checkouts. If selected,
this value is stored globally for the loan session.

Settings
8 print Options [E] workform Defaults # Installation

¥ Apply to all check-outs

£ | Jul $ 219 ¢ > Loan period: 22 Days v

1 2 3 4 5 6 7
8 9 10 11 12 13 14

15 16 17m19 20 21

22 23 24 25 26 27 28

29 30 31

Select Workform Defaults to view the value that is used to calculate the due date if the
user doesn't choose to use the special loan. This value is not editable.

Settings
8 Print Options @ Special Loan [E] Workform Defaults # Installation

Workforms: Offline check out

Standard loan period (days) 14 |
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Select Settings > Installation to view installation settings. All values stored in the web
browser's local storage during Leap Offline installation are displayed.

Settings

& Print Options O Special Loan [ Workform Defaults # Installation

Branch User Workstation

ID: 25 ID: 6085 1D: 3292

Name: Community Library Name: cherylstewart Name: Stewart-LT
Home Page: Organization ID: 25
Phone Number: 518-234-7897

Receipt Note: Sooner is usually better than later.

Miscellaneous Version
Loan Period: 14 Offline: 1.0
Locale Name: en-US Polaris: 6.3.2269.0

Uploading Offline Transactions

If you have unprocessed offline transactions when you log into Leap, you will see the
following message:

FIND New~  Utiities  Help~ I cheryl stewart (COB) »

1 unprocessed offline transactions detected S PRINT

The User profile icon is also set to the Warning icon. Select the icon to access options
to process the offline transactions.

» The Send Offline Files to Server option sends all unprocessed offline transactions
to the server for processing. All transactions sent to the server will be processed
and uploaded using the Automatic Offline Upload process.

» The Delete My Offline Files options deletes all unprocessed offline transactions
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from the browser. The deleted transactions cannot be recovered.

E 0 cheryl.stewart (COB) ~

# Settings
& Clear Cache

C Refresh Permissions

© Send Offline Files to Server
|IE' Delete My Offline Files |

= Logout
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Columns Added For Display in Leap Item Find Tool

The following configurable columns were added under Column Settings in the Leap Item
Find tool:

e Author

e Due date

e Publication date

e YTD Circ

e Prev YTD Circ

« Lifetime Circ

* YTD in-house use

e Prev YTD in-house use

 Lifetime in-house use

e Public notes

» Non-public notes

» Physical condition

e Copy number

» Assigned branch abbreviation

e PO number

In the Item Find tool select Column Settings:

Find Tool - Item Record

ltem Record » Basic Search » All keyword fields »  Keyword (All) »

Column Settings >

Title Assig. Colle... Mater... Shelf ... |Call ... |V... Status Barcode La Garcn Finer

Record Set Options 2

The added columns can be selected and configured for display in the Item Find tool.
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Find Tool - Item Record

Bib Control Number
Author

Due date

Publication date

YTD Circ

Prev YTD Circ

Lifetime Circ

YTD in-house use
Prev YTD in-house use

Lifetime in-house use

Maiblin nadan

MOVE UP

MOVE DOWN

Column Settings

Display Position
Folded

Name

Pinned

Visible

Width

Display Position
The order of the column in the display

False
True

12.291
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Improvement to Patron Properties in Leap

The patron's birth date is now included in the list of patron information that appears
when you view patron properties in Leap.

LAURA IZQUIERDA ©

P | A12291954
‘ﬁ-’ Cl PATRON INFO - 357715

i Check Out PATRON CODE: RETIRED 2

BIRTH DATE: 1211955 E

‘ XL Profile
— HOME ADDRESS
X Attributes 101 E. MAIN STREET F

SYRACUSE, NY 13210
4 Email

( 0] = . _
# Address PHONE NUMBER: 315-512-5555

t. Phone/Fax EMAIL ADDREESS: LAURA@IN.COM
A Notification EXPIRATION DATE: 11M5/2022

&% Preferenct  \oTiF|CATION OPTION: MAILING ADDRESS

Image
- g VOTER REGISTRATION: YES

O Misc_ Info
PRNWVILEGES f RESTRICTIONS: 4

ID NUMBER: 4
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Improved Sorting for Title Lists in Leap Patron Views

Lists of titles that appear in patron views in Leap are now sorted using Name Authority
Cooperative Program (NACO ) normalization rules.
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Editing Saved Reports in SimplyReports

You can now edit all column and filter settings for the following types of saved reports:
fund list reports, invoice list reports, and purchase order list reports.

You can also edit many other types of saved reports. See the SimplyReports user
documentation for more information.
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